Image
e [GETTING STARTED]

e See details at: http://help.imageanalyst.net/

e Open a recording using the File/”Open Image Series/Measurement” or the \E toolbar button.

o

o O O

o

An internal loader or Bio-Formats can be used for opening files using separate menu items, or during drag-and-drop
based on the preference set in the File/"Set Folder Locations and Default Open Method".

The internal loader is optimized for *.inf, *.nd, *.tif, *.nd2, *.Ism files.

Multi-dimensional files and Bio-Formats open a Multi-Dimensional Open dialog

Multiple files selected are merged in time, with the options for merging as channels or stage positions

X,Y,Z,T recordings are loaded z-projected according to the setting in the Multi-Dimensional Open Dialog Settings tab.

e Image window linkage

o

@)

Opening multi-channel recordings result an Image Window for each channel. These windows are linked, meaning that
share ROIs and are available for image processing in functions which have multiple inputs.

[
Set Image Window linkage using the & toolbar button.

e View image time lapses

o O O

o

Use the © toolbar button to play the time lapse. The speed of playback is set in the Edit/Preferences dialog Misc tab.
Use the % toolbar button to synchronize the view of linked Image Windows.

Use right-click in the Image Window to set lookup table (LUT), scale the image or overlay Image Windows.

Use pipelines such as “Show three color overlay” for quick LUT adjustments and overlay.

e  Processimages

o Allimage processing is floating point and acts on the entire time lapse.

o Basic background subtraction, ROl and Plotting functions are available in the Tools menu, and on the toolbar.

o All other image processing functions can be selected from the menus between “I/0” to “Special”, and pipelines in the
“Pipelines” menu. Functions and pipelines are controlled in the same way, by setting parameters in a list appearing
below the toolbar (see next page). Use the B to0lbar button to process selected images with the current function or
pipeline, or ® to open and process images from a Multi-Dimensional Open dialog.

o A set pre-defined pipelines support many basic tasks for pre-processing fluorescence images for intensity
measurements, morphological measurements and cell counting

e Savedata

o Draw ROIs by hand DN or by magic wand 7 tool which works both on fluorescence and brightfield images.
Automatic ROl drawing tool is available in the “Plotting” menu. An additional customizable automatic ROI drawing tool
is the “Automatic ROI drawing with segmentation” pipeline in the Pipelines menu.

o Use the = toolbar button (Tools/Plot) or the advanced plotting functions in the “Plotting” menu to create plots.

o Use image segmentation to measure morphological parameters or intensities corresponding to segments.

o Plot data can be copied to the clipboard or saved as *.txt files

o Plot and other measurement data also appear in the Excel Data Window when it is opened from the Tools menu.

)
@)

)
O

o

Export processed images

Processed images can be copied to the clipboard or saved as *.jpg or *.avi files.
The original, raw data is read only, it is never changed by the Image Analyst MKII.

Automate the workflow using intuitive flow-chart based pipelines (P)

All advanced functions (f) are available as building blocks in the pipeline window.

Saved pipelines will be compatible with future versions of Image Analyst MKII.

Pipelines can be automatically executed in all stage positions in a Multi-Dimensional data set using the » button,
supporting the work with microplates.
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1. Start here by opening a

Basic Background
Removal and plotting  Pipeline control

ROI functions

age Analyst NIKI

2. Pipelines and image processing functions: 3. Process images
selection of these will open the parameter bar below selected as “Image
A” or “Image B”

Search for pipelines and functions

B -0 13 s BW K O
NN AR Y
Pipeline: Witochondria:czl volume fractionator (basic with pos| | Cell -
Witochondria

Channel number for cyloplasmic stain
Channol nombe q: "" vt st |2 Parameter bar: ‘ W4 (Ch1) s1AIvolu - . . . (use the *File Order” tab),

annel number for mtochondril stain : ) WS (Ch2) s1ANLvolu Description for each function or pipeline i
Channel number for post-hoc stain 1 4 set function or Copy of W1 (Ch1) s shows the COMespoNaiNg IMMUNOTIUOTESCENCe IMAge (USE e green QouUDIe arrow Main 100 bar DUTON 10 SYNchronize Image 3
Channel number for post-hoc stain 2 5 Copy of W2 (Ch2) 57 Window sliderd) and the output needs to be manually gated based on these images, using the Editing/Mask ROIS wiith a fil value of 0 on the binarized
Post-hoc stain 1 color Blue ineli Set Image A *Cel” and “Witodgondria” images. When done, piot data to the Excel Data Window with Plotting/Plot, Plot type=Sum.
Post hoe stain 2 color Red pipeline To process here Image B The algorithm ha} been calibrated to electron microscopy, if using a red fluorescent probe for mitochondria (e.g. MitoTracker Red CMX), the pixel size is
Minimal mean intensity cutoff for the cytaplasmic stain 150000 parameters here Or multiple i ollows protocols given at http://help.imageanalyst net/protocols. himl
Sensitivity scaling for the cytosolic stain (percentile) 98.0000 B o ik is given by the 2/3 times the ratio of the sum of mitochendrial pixels over the sum of all cellular (including mitochondrial) pixels,

if needed Iculated for all recorded images. The sum and ratio calculation takes place in an Excel template. -

P W5 (Ch2) s1AIl volumeratio0lice_Suml.lsm ¥ Mitochondria

J

Multi-Dimensional Open: All_volumeratio0l _Suml.lsm, All_velumeratio0licc_Suml.lsm

Open: | File Order | Settings | Bio-Formats Tweak | Spatial Filter | OpticaFiow Load | Plate

[ posiion 1 (1 au

[/ channel 2 (Al_volumeratiod1_Sum1.lsm 2 Ch2) © None / Projection Only
CRANNE] 3 (£ -rmbmnrmtinid Bt 1nme s = by

¥ channel 4 (+
¥ channel 5 (

volumeratio01_Sum1) -\#_ 0 =

®

Processing

)

Multi-Dimensional Open dialog _
(uniform for all formats) m |1 &

Ie Order tab):

Merge in Time
© Merge as Channels
Merge as Postions

Swap dimensions:
Posttions as Time lapse

= Channels as Z or OF

m

Close All Before ‘ G?UpenNext PE Open

m

=
=

nowosshl Topls menu. Then data from 8336403

12 |no crossbl £ 7.26E+03

13 nocrossui all plotting functions will 5886403

14 |no crossbl/ appear here 4.31E+03

15 |no crossbl/ 9.89E+03

16 nocrossbl4 _ _ 6.99E+03

17 |no crossbl All_volum 1 All_volu Sum Plot ¢ 12 50609 3.10E+03 Threshold
18 |no crossbl All_volum 1 All_volu Sum Plot ¢ 13 46311 8.55E+03 Threshold
19 |no crossbl All_volum 1 All_volu Sum Plot ¢ 14 64348 1.39E4+04

20 |no crossbl All_volum 1 All_volu Sum Plot ¢ 15 63980 1.38E+04 [

21 |no crossbl All volum 1 All volu Sum Plot ¢ 16 51243 6.24E+03

4 4 b M| IA Output ~¥3 Ll m,

(444,56) 46.000 280545 (30/31)  50% ROIs:1 (1) (4,786) 0 469325(30/31)  S0% ROIs1 (1) (/N B W% oond
B Dats = | & [ 2 | |[ 4 Mitochondria:cell volume fractionater (basic with post-hoc staining) = =] = |
A B c D E F G H BL. Bl B nput
o s k2 | o -
1 |Mmito:Cell Volume Fractionator Template e =
2 |Sum of cell pixel 2.E406 Volume fractio 6.98% ~ | Parameters of the pipeine | Deseription
3 sumofmitopixels=  3.E+405 Pipeline Window \aster Parameters
4 Plot Resul Using pipe Chl: Sum PlotcCha: sum Plot of Mitochondria Invoke thlS Channel number for cytoplasmic stain 1
5 |FolderNaf Eycal Data Window is the Ch2_ROI1 Ch3 R . Channel number for mitochondrial stain 2
6 nocrossbl/ ) 1.49E+04 window from the =| || channel number for post-hoc stain 1 4
7 |nocrossbl; MOSt convenient output of 5.50E+03 Tools or Channel number for post-hoc stain2 5
il | & |nocrossblz measurements 0.00E+00 Post-hoc stain 1 color Blue
9 |nocrossbls o 4136403 PipelineDesigner Pust-hoc stai 2 color Red
10 |no crossbi; INvoke this window from the 10704 menus inimal mean intenstty cutoff for the cyto 15.0000

Senstivity scaling for the cytosolic stain 92.0000

Done. Free:7183.012 Mb

Data copy to table ready. / Calculating plot / Plot calculation ready.
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Opening Multi-dimensional files and Bio-Formats open a Multi-Dimensional Open dialog that allows selection of stage positions and
channels to be loaded and also processing during or after loading.

Tag of the Multi-Dimensional
Open dialog: refer to this tag
from pipelines using multiple
input image datasets, such as
iost-hoc staining recordings

Multi-Dimensional Open: #2-4APTEATTXoligoK.lsm

Each loaded frame is
Open: | File Order | Settings | Bio-Formats Tweak | Spatial Fiter | OpticaFiow Load | PiXe |

processed according to

Select stage ———3bposition 1 (1 #2-4APTEATTXoligok) e - ]
. — +~ these settings. See
position ¥ channel 1 (1 Ch2-T1) Processing:
channel 2 (2 ChO-T1} (@) Mone / Projection Only corresponding tabs.
> 1% I'II'IE (7 Spatial Fitering
nne - . . .
Select () Optical Flow — The “None” setting will
(™) Single Time Point: 1 ] .
channel - read raw time courses
File merge (see File Order tab): .
oe ' of XYT recordings and z-

1z frames ~ (@ Merge in Time

4 channels () Merge as Channels projection of XYZT
1 stage positions M Positi i
Information 1988 images total in the first series 2 e recordmgs (Set the type
1988 planes total in the first seri L imensions: iecti i
about the oy e Totalin fhe frst series =‘ %‘f::sdﬁ':::z'ﬁm D of projection or which
. - frames to project in the
Image = []channels as Z or OF N
dataset(s) - - _ Settings” tab.
{O Defauts |7 - [::lCIuseAII Before hi Open MNext D" Open x
opened. \ - =
Menu to store the Multiple files are
actual settings as merged based on
default, or to set this Pipeline automation button: Setting this oot il | these settings. See
etting this option will close a ;
dialog as default for . g P ) also the File Order
o i Load and process single or Image and Plot windows when tab
pipeline processing . -, . )
multiple positions using the the Open or Open Next buttons
pipeline selected from the are pressed.
main menu

e Use the “File Order” tab to add, remove or reorder multiple files.

e Use the “Settings” tab to open specific ranges of frames in t or z dimensions and to select how to z-project XYZT recordings.
e Use the “Plate” tab to reassign multiwall plate well names to each position.

e The “Spatial Filter” and “Optical Flow” tabs offer specific during-loading image processing.
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e Select a pipeline in the Pipeline menu. The selected pipeline can be used in the main parameter bar and executed by the r,*
or ® buttons. In order to edit the pipeline, the pipeline window can be opened using the P button. All built-in pipelines can
be modified.

e An Empty Pipeline window can be opened with the PipelineDesigner/New Pipeline Window menu point.

e Toload an arbitrary pipeline, use drag-and-drop, or open an empty Pipeline Window and press the open button Us.

Add, delete or copy function Parameters or
(drop where you want to place) description
of the function

The lock prevents accidental change of the block
diagram, but parameters can be still edited

Run pipeline on selected image

or in the single or multiple positions in
the active Multi-Dimensional Open dialog

Select and add another function
(drop where you want to place)

Prepare two channel til (27
BRED &-F™ +XDpeoE-RO
Input image Parameters of Align Channels | Description | =
- - unction: Align Channels
Sub pixel accuracy es |Z|
Magnification factor 4.0000 -
Working image size, exponent of 2 =int(log(2, min{imagesizex,imagesizey)))+2=10 2
Get Linked Channel Based on single frame No - g
- - Interpolation type Linear )
Inprint Mask lmage Arithmetic Inprint Mask Transform all linked images No ("-Dr
Subtract Background Cancel transformation if the shift is great 0.0000 «
Set scaling/LUT Based on frame(s): First

Input #1 [P] Get Linked Channel 1 —
|Write back scaled values| Input #2 [C] Get Linked Channel 2 B -3
Select function, || output#1[c] Get Linked Channel <
and set Output #2 [C] Get Linked Channel g
parameters on g.
the right )
Align Series g
c
@
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RULES OF PIPELINE EDITING:

e  Always start with an input image.

e Select functions to add by pressing the ?button.

g 2 — .
bLED &-F™ XD PO @e--mo
vo |F put — Farameters of gt Fage | ]
Editing » § GetLinked Channel h N Functon out mage
Plotting » § Openfile Image Window {Actus! window] =
Filters »| & Multi-Dimensional Open Stage Position
Math *|F Mutti-Dimensional Reload Channel

Segmentation | § NewImage

Appesrance ¥ §F Copy

‘Special M F Lk

TTTTTTTTTTF Close

F Rename
& SetReferenceImage
& Getlmage Information
& Muhi-Dimensional Open Information
F ©port
F Losd and Run Pipeline
& Windows Menu Command
F Wit for All nputs
§  Excel Window Command

e Place new functions in an empty area then drag-and-drop onto their inputs.

DD 8-F o +XDiBP

Parameters of Get Linked Chanel | Descrpton

Funcson Get Linked Crannel
Channel (V) 1

(Get Linked Channel

e Red functions are inputs, seek for certain channel or create a new image.
e Black functions are in place operations; Only one black function can be immediately downstream of any function.
e Green and blue functions do not produce output images, so these are dead ends in the flow chart.
e  Placed functions can be freely renamed for more intuitive diagrams.
e Reorder the inputs if needed on the right, by clicking the button appearing at the end of the “Input #” entry.
Y ————— R o oon )
BRED A-F™ +X0BPo

Input image Parameters of Align Channels ‘Desm"‘
Function: Align Channels

Get Linked ChannGe' Linked Channel 2 Sub pixel acouracy ves

Wagnification factor 40000
Working image size, exponent o7 2 =intilog(2,min(imagesizex, imagesizey)))+2=10

Get Linked Channel Get Linked Channel Based on sigle frame o

Interpolation type Linear
Inprint Mask Image Arthmelic Inprint Mask Transform all inked images No

Subtract B Subtract B Cancel if the shift is great 0.0000

Set scaling/LUT Based on frame(s); First
Input #1 [P] Get Linked Channel 1|
Write back scaled values Input #2 [C] Get Linked Channel 2

Output #1 [C] Get Linked Channel
Output #2 [C] Get Linked Channel

‘Align Series

Image Windows. Furthermore the timing of parallel branches is not predictable, therefore certain designs may result in
variable order of data output. Pipeline processing starts simultaneously in all Inputs.
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ADDING MASTER PARAMETERS TO PIPELINES

Pipelines can have master parameters (these are the parameters shown in the main parameter bar of Image Analyst MKII) that

relate to one or more function parameters within the pipeline.

Press the (o) button in the toolbar of the (unlocked) Pipeline Window.
Select a function parameter that you want to use as a pipeline parameter.
Click the first empty cell in the Caption column in the bottom.

Click the button at the end of the Caption edit and “Add the parameter.

Puramears o Gt Loked Charat 1 [Descreion]

Vaive (sparam) Comsirants Error Message *
! e e o
ot s [
St ot ¥
e hamirer i | 2
eamoueats o b |

S

Get Linked Channe]

o Linked Channel
o Channels
‘m\ammmm E

Multiple parameters of the same type (integer, real, Boolean or text) can be added to each pipeline parameter.
To switch between linked parameters, use the picklist in the Assign To column.

Vs (sparan) Consirants. Ervor Message

The numerical value of a pipeline parameter can be assigned to a function parameter by expressing it using a mathematical
formula started with an equation mark typed in the parameter of the function, and referring to the associated pipeline
parameter as “param”. Thus =2*param will pass the double of the value of the pipeline parameter to the given function.
See details on the math parser (evaluator) in the Help menu or (see http://help.imageanalyst.net/workflow_parser.html).
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